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artus HSV-1/2 TM PCR Kit 
For use with the ABI PRISM 7000 and 7900HT Sequence Detection. 

Attention: The artus HSV-1/2 TM PCR Kit may neither be used in combination 
with the GeneAmp® 5700 SDS, neither with the ABI PRISM 7700 SDS nor with 
the 384 plate format of the ABI PRISM 7900HT SDS. 

1.  Contents 

 Labelling and contents Art. No. 4500163 
24 reactions 

Art. No. 4500165 
96 reactions 

Blue HSV TM Master 2 x 12 rxns 8 x 12 rxns 

Blue  HSV TM Master  2 x 12 rxns  8 x 12 rxns 

Yellow HSV TM Mg-Sol¤ 1 x 1,200 µl  1 x 1,200 µl 

Red  HSV1 LC/RG/TM QS 1¤ 
1 x 104 cop/µl  

1 x 200 µl  1 x 200 µl 

Red  HSV1 LC/RG/TM QS 2¤ 
1 x 103 cop/µl  

1 x 200 µl  1 x 200 µl 

Red  HSV1 LC/RG/TM QS 3¤ 
1 x 102 cop/µl  

1 x 200 µl  1 x 200 µl 

Red  HSV1 LC/RG/TM QS 4¤ 
1 x 101 cop/µl  

1 x 200 µl  1 x 200 µl 

Red  HSV2 LC/RG/TM QS 1¤ 
1 x 104 cop/µl  

1 x 200 µl 1 x 200 µl 

Red  HSV2 LC/RG/TM QS 2¤ 
1 x 103 cop/µl  

1 x 200 µl  1 x 200 µl 

Red  HSV2 LC/RG/TM QS 3¤ 
1 x 102 cop/µl 

1 x 200 µl  1 x 200 µl 

Red  HSV2 LC/RG/TM QS 4¤ 
1 x 101 cop/µl 

1 x 200 µl 1 x 200 µl 

Green HSV TM IC¤ 1 x 1,000 µl 2 x 1,000 µl 

White Water (PCR grade) 1 x 1,000 µl 1 x 1,000 µl 
 

¤ QS = Quantitation Standard 
  IC = Internal Control 
 Mg-Sol = Magnesium Solution 
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2. Storage 
The components of the artus HSV-1/2 TM PCR Kit should be stored at –30°C to 
–15°C and are stable until the expiry date stated on the label. Repeated thawing 
and freezing (> 2 x) should be avoided, as this may reduce the sensitivity. If the 
reagents are to be used only intermittently, they should be frozen in aliquots. 
Storage at +4°C should not exceed a period of five hours. 

3. Additionally Required Materials and Devices 
 Disposable powder-free gloves 

 DNA isolation kit (see 8.1 DNA Isolation) 

 Pipettes (adjustable) 

 Sterile pipette tips with filters 

 Vortex mixer 

 Desktop centrifuge with rotor for 2 ml reaction tubes 

 Centrifuge with rotor for microtitre plates (optional) 

 96-well reaction plate/reaction tubes for optical measurement with 
corresponding optical closing materials (see 8.4 Preparing the PCR) 

 96-well two-part retaining rack for use with optical reaction tubes (96-Well 
Tray/Retainer Set, Cat. No. 403 081, Applied Biosystems), see 8.4 
Preparing the PCR 

 Compression pad for use with optical adhesive covers (Optical Cover 
Compression Pads, Cat. No. 4 312 639, Applied Biosystems), see 8.4 
Preparing the PCR 

 Applicator for sealing of the reaction plates using optical adhesive covers 
(Adhesive Seal Applicator Kit, Cat. No. 4 333 183, Applied Biosystems) 

 ABI PRISM 7000 or 7900HT SDS 

Attention: A valid calibration of the pure dyes (Pure Spectra Component File) 
and the background (Background Component File) is necessary when putting 
the instruments into operation. 
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4. General Precautions 
The user should always pay attention to the following: 

 Use sterile pipette tips with filters. 

 Store and extract positive material (specimens, controls and amplicons) 
separately from all other reagents and add it to the reaction mix in a 
spatially separated facility. 

 Thaw all components thoroughly at room temperature before starting an 
assay. 

 When thawed, mix the components and centrifuge briefly. 

 Work quickly on ice or in a cooling block. 

5. Pathogen Information 
Herpes simplex virus (HSV) is found in lesion fluids, saliva and vaginal 
secretions. It is transmitted primarily by direct contact with lesions and via sexual 
intercourse, as well as perinatally. Lesions on the skin and mucous membranes 
of the mouth and genitals characterize most HSV positive cases. HSV infection 
can be either primary (> 90 % of these cases are asymptomatic) or recurrent 
(secondary). Primary infection with HSV-1 can lead to, among others, 
gingivostomatitis, eczema herpeticum, keratoconjunctivitis and encephalitis; 
primary HSV-2 infection occurs as, among others, vulvovaginitis, meningitis and 
generalized herpes in newborns. The primary symptoms of a secondary 
infection are skin lesions in the nose, mouth and genital regions. Even more 
severe are the recurrent forms of keratoconjunctivitis and meningitis. 

6. Principle of Real-Time PCR 
Pathogen diagnosis by the polymerase chain reaction (PCR) is based on the 
amplification of specific regions of the pathogen genome. In real-time PCR the 
amplified product is detected via fluorescent dyes. These are usually linked to 
oligonucleotide probes which bind specifically to the amplified product. 
Monitoring the fluorescence intensities during the PCR run (i.e. in real-time) 
allows the detection and quantitation of the accumulating product without 
having to re-open the reaction tubes after the PCR run (Mackay, 2004). 

7. Product Description 
The artus HSV-1/2 TM PCR Kit constitutes a ready-to-use system for the 
detection and differentiation of herpes simplex virus-1 and -2 DNA using 
polymerase chain reaction (PCR) in the ABI PRISM 7000 and 7900HT Sequence 
Detection System. The HSV TM Master contains reagents and enzymes for the 
specific amplification of a 148 bp region of the herpes simplex virus genome. 
The amplicon is detected by measuring the FAM fluorescence (HSV-1) and NED 
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fluorescence (HSV-2) in the ABI PRISM SDS. In addition, the artus HSV-1/2 TM 
PCR Kit contains a second heterologous amplification system to identify possible 
PCR inhibition. This is detected as an Internal Control (IC) by measuring the VIC 
fluorescence. The detection limit of the analytical HSV PCR (see 11.1 Analytical 
Sensitivity) is not reduced. External positive controls (HSV1 LC/RG/TM QS 1 – 4 
& HSV2 LC/RG/TM QS 1 – 4) are supplied which allow the determination of the 
pathogen load. For further information, please refer to section 
8.3 Quantitation. 

8. Protocol 

8.1 DNA Isolation 
Various manufacturers offer DNA isolation kits. Sample amounts for the DNA 
isolation procedure depend on the protocol used. Please carry out the DNA 
isolation according to the manufacturer’s instructions. The following isolation 
kits are recommended: 

Sample 
Material 

Nucleic Acid 
Isolation Kit 

Catalogue 
Number Manufacturer 

Carrier 
RNA 

Serum, 
plasma, CSF, 
swabs 

QIAamp® 
UltraSens® Virus 

Kit (50)  

53 704  QIAGEN  included 

QIAamp DNA 
Mini Kit (50)  

51 304  QIAGEN  not 
included 

CSF EZ1® DSP Virus 
Kit (48)*  

62 724  QIAGEN  included 

 

* To be used in combination with the BioRobot® EZ1 DSP Workstation (Cat. No. 9001360) and 
the EZ1 DSP Virus Card (Cat. No. 9017707). 
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Important note for the use of the QIAamp UltraSens Virus Kit and the 
QIAamp DNA Mini Kit: 

 The use of carrier RNA is critical for the extraction efficiency and, 
consequently, for DNA/RNA yield. If the selected isolation kit does not 
contain carrier RNA, please note that the addition of carrier 
(RNAHomopolymer Poly(A), Amersham Biosciences, Cat. No. 27-4110-01) 
is strongly recommended for the extraction of nucleic acids from cell free 
body fluids and material low in DNA/RNA content (e.g. CSF). Please 
proceed as follows in these cases: 

a) Resuspend the lyophilised carrier RNA using the elution buffer (do not use 
lysis buffer) of the extraction kit (e.g. AE buffer of the QIAamp DNA Mini 
Kit) and prepare a dilution with a concentration of 1 µg/µl. Divide this 
carrier RNA solution in a number of aliquots adequate to your needs and 
store them at –20°C. Avoid repeated thawing (> 2 x) of a carrier RNA 
aliquot. 

b) Use 1 µg carrier RNA per 100 µl lysis buffer. For instance, if the 
extraction protocol suggests 200 µl lysis buffer, please add 2 µl carrier 
RNA (1 µg/µl) directly into the lysis buffer. Before beginning of each 
extraction, a mixture of lysis buffer and carrier RNA (and Internal Control, 
where applicable, see 8.2 Internal Control) should be prepared freshly 
according to the following pipetting scheme: 

Number of samples 1 12 

Lysis buffer  e.g. 200 µl  e.g. 2,400 µl 

Carrier RNA (1 µg/µl)  2 µl  24 µl 

Total Volume  202 µl  2,424 µl 

Volume per extraction  200 µl  each 200 µl 
 

 

c) Please use the freshly prepared mixture of lysis buffer and carrier RNA 
instantly for extraction. Storage of the mixture is not possible. 
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 The use of carrier RNA is critical for the extraction efficiency and, 
consequently, for DNA/RNA yield. To increase the stability of the carrier 
RNA provided with the QIAamp UltraSens Virus Kit, we recommend the 
following procedure deviant from the user manual of the extraction kit: 

a) Resuspend the lyophilised carrier RNA prior to first use of the extraction 
kit in 310 µl of the elution buffer provided with the kit (final concentration 
1 µg/µl, do not use lysis buffer). Portion this carrier RNA solution into a 
number of aliquots adequate to your needs and store them at –20°C. 
Avoid repeated thawing (> 2 x) of a carrier RNA aliquot. 

b) Before the beginning of each extraction, a mixture of lysis buffer and 
carrier RNA (and Internal Control, where applicable, see 8.2 Internal 
Control) should be prepared freshly according to the following pipetting 
scheme: 

Number of samples 1 12 

Lysis buffer AC  800 µl  9,600 µl 

Carrier RNA (1 µg/µl)  5.6 µl  67.2 µl 

Total Volume  805.6 µl  9,667.2 µl 

Volume per extraction  800 µl  each 800 µl 
 

 

c) Please use the freshly prepared mixture of lysis buffer and carrier RNA 
instantly for extraction. Storage of the mixture is not possible.  

 It is recommended to elute the DNA in 50 µl elution buffer to get the 
highest sensitivity of the artus HSV-1/2 TM PCR Kit. 

 The QIAamp UltraSens Virus Kit allows a sample concentration. If you 
use sample material other than serum or plasma, please add at least 50 % 
(v/v) of negative human plasma to the sample. 

 When using isolation protocols with ethanol-containing washing buffers, 
please carry out an additional centrifugation step (three minutes, 
13,000 rpm) before the elution to remove any remaining ethanol. This 
prevents possible inhibition of PCR. 

 The artus HSV-1/2 TM PCR Kit should not be used with phenol-based 
isolation methods. 

Important note for the use of the EZ1 DSP Virus Kit: 

 The use of carrier RNA is critical for the extraction efficiency and, 
consequently, for DNA/RNA yield. Please add the appropriate amount of 
carrier RNA to each extraction following the instructions in the EZ1 DSP 
Virus Kit Handbook. 
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Important: The Internal Control of the artus HSV-1/2 TM PCR Kit can be used 
directly in the isolation procedure (see 8.2 Internal Control). 

8.2 Internal Control 
An Internal Control (HSV TM IC) is supplied. This allows the user both to 
control the DNA isolation procedure and to check for possible PCR 
inhibition (see Fig. 1). Using the EZ1 DSP Virus Kit for extraction, the Internal 
Control has to be added following the instructions in the EZ1 DSP Virus Kit 
Handbook. Using the QIAamp UltraSens Virus Kit or the QIAamp DNA 
Mini Kit, add the Internal Control to the isolation at a ratio of 0.1 µl per 1 µl 
elution volume. For example, using the QIAamp DNA Mini Kit, the DNA is 
eluted in 50 µl AE buffer. Hence, 5 µl of the Internal Control should be added 
initially. The quantity of Internal Control used depends only on the elution 
volume. The Internal Control and carrier RNA (see 8.1 DNA Isolation) should be 
added only 

 to the mixture of lysis buffer and sample material or 

 directly to the lysis buffer. 

The Internal Control must not be added to the sample material directly. If added 
to the lysis buffer please note that the mixture of Internal Control and lysis 
buffer/carrier RNA has to be prepared freshly and used instantly (storage of the 
mixture at room temperature or in the fridge for only a few hours may lead to 
Internal Control failure and a reduced extraction efficiency). Please do not add 
the Internal Control and the carrier RNA to the sample material directly. 

The Internal Control can optionally be used exclusively to check for possible 
PCR inhibition (see Fig. 2). For this application, add 2 µl of the Internal Control 
and 10 µl HSV TM Mg-Sol per reaction directly to 20 µl HSV TM Master. For 
each PCR reaction use 30 µl of the Master Mix produced as described above* 
and add 20 µl of the purified sample. If you are preparing a PCR run for 
several samples please increase the volume of the HSV TM Master, the HSV TM 
Mg-Sol and the Internal Control according to the number of samples (see 8.4 
Preparing the PCR). 

8.3 Quantitation 
The enclosed Quantitation Standards (HSV1 LC/RG/TM QS 1 – 4 & HSV2 
LC/RG/TM QS 1 – 4) are treated as previously purified samples and the same 
volume is used (20 µl). To generate a standard curve on an ABI PRISM 
Sequence Detection System, all four Quantitation Standards of HSV-1 as well as 
HSV-2 should be used and defined as standards with specification of the 
corresponding concentrations (see 8.5 Programming the ABI PRISM SDS). The 

* The volume increase caused by adding the Internal Control is neglected when preparing the 
PCR assay. The sensitivity of the detection system is not impaired. 
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import of standard curves from previous runs is not possible with the ABI PRISM 
7000 and 7900HT SDS software. 

Attention: The Quantitation Standards are defined as copies/µl. The following 
equation has to be applied to convert the values determined using the standard 
curve into copies/ml of sample material: 

 

Result (copies/ml)         = 
Result (copies/µl) x Elution Volume (µl)  

Sample Volume (ml)  

 

Please note that as a matter of principle the initial sample volume should be 
entered in the equation above. This has to be considered when the sample 
volume has been changed prior to the nucleic acid extraction (e.g. narrowing 
the volume by centrifugation or increase of volume by replenishment to the 
volume required for the isolation). 

Important: A guideline for the quantitative analysis of artus systems on the ABI 
PRISM 7000 SDS is provided at 
www.qiagen.com/Products/ByLabFocus/MDX (Technical Note for 
quantitation on the ABI PRISM 7000 SDS). 
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8.4 Preparing the PCR 
Prepare the number of required reaction tubes or a 96-well reaction plate for 
the scheduled reactions. Recommended materials are listed in the following 
table: 

Article  Description  
Catalogue 
Number  Manufacturer  

Retaining 
Rack* 

Compression 
Pad 

96-well 
optical 
reaction 
plate  

96-Well 
Optical 
Reaction 

Plate  

4 306 737 Applied 
Biosystems 

no  – 

Optical 
adhesive 
covers  

Optical 
Adhesive 
Covers 

4 311 971 Applied 
Biosystems 

- Yes 

Optical 
reaction 
tubes 

ABI PRISM 
Optical 
Tubes, 8 

Tubes/Strip 

4 316 567 Applied 
Biosystems 

yes – 

Optical 
reaction 
tubes  

MicroAmp® 
Optical 
Tubes  

N8010933  Applied 
Biosystems 

yes – 

Optical 
caps 
(flat)  

ABI PRISM 
Optical 
Caps, 8 

Caps/Strip 

4 323 032 Applied 
Biosystems 

- no 

 

 

When preparing the PCR reaction, please make sure that at least one 
Quantitation Standard per PCR run as well as one negative control (Water, PCR 
grade) are performed in parallel. To generate a standard curve, use all 
supplied Quantitation Standards (HSV1 LC/RG/TM QS 1 – 4 & HSV2 LC/RG/TM 
QS 1 – 4) for each PCR run. Before each use, all reagents need to be thawed 
completely, mixed (by repeated up and down pipetting or by quick vortexing) 
and centrifuged briefly. 

If you want to use the Internal Control to monitor the DNA isolation 
procedure and to check for possible PCR inhibition, it has already been 

* If the two-part retaining rack is used, it is necessary to open the reaction tubes when inserting 
them into and removing them from the rack. In order to avoid contamination due to this 
procedure, please use the lower part of the retaining rack only. 
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added to the isolation (see 8.2 Internal Control). In this case, please use the 
following pipetting scheme (for a schematic overview see Fig. 1): 

 
Number of 

samples 1 12 

1. Preparation of Master 
Mix 

HSV TM Master 20 µl 240 µl 

HSV TM Mg-Sol 10 µl 120 µl 

HSV TM IC 0 µl 0 µl 

Total Volume 30 µl 360 µl 

2. Preparation of PCR 
assay 

Master Mix 30 µl 30 µl each 

Sample 20 µl 20 µl each 

Total Volume 50 µl 50 µl each 
 

 

If you want to use the Internal Control exclusively to check for PCR inhibition, 
it must be added directly to the HSV TM Master. In this case, please use the 
following pipetting scheme (for a schematic overview see Fig. 2): 

 Number of samples 1 12 

1. Preparation of Master Mix HSV TM Master 20 µl 240 µl 

HSV TM Mg-Sol 10 µl 120 µl 

HSV TM IC 2 µl 24 µl 

Total Volume 32 µl* 384 µl* 

2. Preparation of PCR assay Master Mix 30 µl* 30 µl* each 

Sample  20 µl 20 µl each 

Total Volume  50 µl  50 µl each 
 

 

Pipette 30 µl of the Master Mix into each required reaction tube or well of the 
96-well reaction plate. Subsequently add 20 µl of the eluate from the DNA 
isolation. Mix the solution well by repeated up and down pipetting. Close the 
reaction tubes with the corresponding caps or, alternatively, when using a 96-
well reaction plate, with optical adhesive covers (Optical Adhesive Covers). 
Centrifuge the reaction tubes (in a storage rack for PCR tubes) or the 96-well 

* The volume increase caused by adding the Internal Control is neglected when preparing the 
PCR assay. The sensitivity of the detection system is not impaired. 
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reaction plate in a centrifuge with a microtitre plate rotor for 30 seconds at 
1,780 x g (4,000 rpm) in order to collect the prepared reaction volume in the 
bottom of the tube or well. If such a centrifuge is not at your disposal, please 
make sure that both the Master Mix and the sample volume are pipetted to the 
bottom of the tubes or wells. Store the prepared reactions at +4°C until the ABI 
PRISM SDS Instrument is programmed (see 8.5 Programming the ABI PRISM 
SDS) and subsequently transfer them into the instrument. 

Attention: 

 When using optical reaction tubes in combination with optical caps, always 
insert a retaining rack (96-Well Tray/Retainer Set) into the instrument (ABI 
PRISM 7000 and 7900HT SDS). If the two-part retaining rack is used, it is 
necessary to open the reaction tubes when inserting them into and 
removing them from the rack. In order to avoid contamination due to this 
procedure, please use the lower part of the retaining rack only. 

 Using 96-well optical reaction plates in combination with optical adhesive 
covers requires covering by a compression pad (Optical Cover 
Compression Pads). 
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Addition of the Internal Control to the Purification Procedure 

 
Fig. 1: Schematic workflow for the control of both the purification procedure and PCR 
inhibition. 

*Please make sure that the solutions are thawed completely, mixed well and 
centrifuged briefly. 
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Addition of the Internal Control into the artus Master 

 
Fig. 2: Schematic workflow for the control of PCR inhibition. 

*Please make sure that the solutions are thawed completely, mixed well and centrifuged 
briefly. 
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8.5 Programming the ABI PRISM SDS 
The software of the ABI PRISM 7000 and 7900HT Sequence Detection Systems 
(SDS) requires some additional information before starting the PCR run. The 
programming procedures of the instruments, however, differ considerably from 
each other, which is why they are treated in separate chapters as follows. 

8.5.1 Programming the ABI PRISM 7000 SDS 

For the detection of HSV DNA, create a profile on your ABI PRISM 7000 SDS 
according to the following six steps (8.5.1.1 – 8.5.1.6). All specifications refer to 
the ABI PRISM 7000 SDS software version 1.0.1. For programming details of the 
ABI PRISM 7000 SDS, please refer to the ABI PRISM 7000 SDS User Guide. For a 
better overview, the software settings are framed in bold black. 

8.5.1.1 Pre-Settings for Creating a New PCR Run 

Select the item New from the File menu on the ABI PRISM 7000 SDS and 
programme the following initial settings for the new document (see Fig. 3). A 
backup template (SDS Template [*.sdt]) is available from the Template list or by 
selection using the Browse function (see 8.5.1.5 Saving the PCR Run). 

Confirm your pre-settings (OK). 

 
Fig. 3: Pre-settings for creating a new PCR run (New Document). 

8.5.1.2 Creating/Selecting the Detectors 

With the help of the submenu Detector Manager from the Tools menu, assign 
the corresponding detector dyes to the file. For the detection of HSV DNA as 
well as the Internal Control by means of the artus HSV-1/2 TM PCR Kit, the 
reporters/quenchers listed in the following table are to be defined: 
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Detection  Reporter  Quencher 

HSV-1 DNA  FAM  None 

HSV-2 DNA  NED  None 

Internal Control (HSV TM IC)  VIC  none 
 

 

To create these detectors, select the option File (bottom left of the Detector 
Manager) and subsequently the option New. 

  

Fig. 4: Creating the HSV-1 specific detector 
(Detector Manager). 

Fig. 5: Creating the HSV-2 specific detector 
(Detector Manager). 

 
Fig. 6: Creating the IC specific detector (Detector Manager) for HSV-1/HSV-2. 

For the detection of HSV-1 DNA or HSV-2 DNA define the reporter/quencher 
combination FAM/none or NED/none in the new window. For the detection of 
the Internal Control, select the combination VIC/none (as shown in Fig. 4 – 
Fig. 6). By confirming the input data (OK), return to the Detector Manager. 

18 artus HSV-1/2 TM PCR Kit 03/2015 



 

Mark the newly created detectors and transfer each selection to the Well 
Inspector by clicking on the option Add to Plate Document (see Fig. 7). Close 
the window (Done). 

 
Fig. 7: Selecting the detectors (Detector Manager). 

8.5.1.3 Assigning the Necessary Information to the Plate Positions 

Open Well Inspector from the View menu to find the detectors selected under 
8.5.1.2 (see Fig. 8 – Fig. 9). 

 
Fig. 8: Assigning the necessary information (HSV-1) to the plate positions (Well Inspector). 

 
Fig. 9: Assigning the necessary information (HSV-2) to the plate positions (Well Inspector). 

artus HSV-1/2 TM PCR Kit 03/2015 19 



Mark the plate positions reserved for the detection of HSV DNA. Assign the 
selected detectors to these positions by activating the Use option of all three 
detectors, upon which a tick will appear. For the denomination of each single 
reaction, select the corresponding position on the plate and enter the name 
(Sample Name). Please note that preparations with an identical Sample Name 
and an identical detector assignment will be identified as replicates by the 
software and will be averaged with respect to the quantified pathogen load. 

Then select the corresponding function (Task) for each sample type according to 
the following table: 

Sample 
Type  

Function 
(Task)  

Concentration 
(Quantity)  

Reporter 
HSV-1  

Reporter 
HSV-2  Quencher 

Sample  Unknown  – FAM  NED  none 

Non-
template 
control 

NTC  – FAM  NED  none 

Standard  Standard  see 1. Contents  FAM  NED  none 
 

 

To generate a standard curve, use all supplied Quantitation Standards (HSV1 
LC/RG/TM QS 1 – 4 & HSV2 LC/RG/TM QS 1 – 4) per PCR run and enter the 
corresponding concentrations (see 1. Contents) for each standard (Quantity). 
Please note that for a PCR run with the artus HSV-1/2 TM PCR Kit, ROX has to 
be set as a passive reference (Passive Reference). The equal distribution of the 
ROX dye in all PCR preparations of a lot by mixing of the HSV TM Master 
guarantees the recognition and calculation of tube-to-tube variations 
(fluorescence differences between several PCR preparations) by means of the 
Sequence Detection Software (normalization). 

8.5.1.4 Creating the Temperature Profile 

To create a temperature profile, switch from the Setup level to the Instrument 
level in the software. Enter the temperature profile specific for the detection of 
HSV DNA according to Fig. 10. In order to remove the 50°C step stored in the 
pre-settings, mark it with the left mouse button simultaneously holding the shift 
key, and subsequently delete it by using the backspace key. Make sure that the 
reaction volume is set to 50 µl. The option 9600 Emulation should be activated, 
the pre-settings of the Auto Increment should remain unchanged (Auto 
Increment: 0.0°C, 0.0 Seconds). 

20 artus HSV-1/2 TM PCR Kit 03/2015 



 

 
Fig. 10: Creating the temperature profile. 

8.5.1.5 Saving the PCR Run 

Save the settings (Setup) as a template in order to make use of them again later 
in a modified or unchanged form. By saving the settings as a SDS Template 
(*.sdt) in the Template Directory (Local Disk [C:]\Program Files\ABI PRISM 
7000\Templates, created by Applied Biosystems), this file may be selected 
directly in the New Document window from the Template drop-down list. Copies 
stored in other folders have to be opened via Browse. Before starting the PCR 
run, save it again as a SDS Document (*.sds), in order to guarantee the saving 
of the data that will be collected during the course of the PCR. 

8.5.1.6 Starting the PCR Run 

Start the PCR run by selecting the option Start 

8.5.2 Programming the ABI PRISM 7900HT SDS 

For the detection of HSV DNA, create a profile on your ABI PRISM 7900HT SDS 
according to the following six steps (8.5.2.1 – 8.5.2.6). All specifications refer to 
the ABI PRISM 7900HT SDS software version 2.1. For programming details of 
the ABI PRISM 7900HT SDS, please refer to the ABI PRISM 7900HT SDS User 
Guide. For a better overview, the software settings are framed in bold black. 

8.5.2.1 Pre-Settings for Creating a New PCR Run 

Select the item New from the File menu on the ABI PRISM 7900HT SDS and 
programme the following initial settings for the new document (see Fig. 11). A 
backup template (ABI PRISM SDS Template Document [*.sdt]) is available from 
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the Template list or by selection using the Browse function (see 8.5.2.5 Saving 
the PCR Run). Confirm the pre-settings (OK). 

Attention: The artus HSV-1/2 TM PCR Kit may not be used in combination with 
the 384 plate format of the ABI PRISM 7900HT SDS. 

 
Fig. 11: Pre-settings for creating a new PCR run (New Document). 

8.5.2.2 Creating/Selecting the Detectors 

With the help of the submenu Detector Manager from the Tools menu 
(alternatively: Setup level/Add Detector select function), assign the 
corresponding detector dyes to the file. For the detection of HSV DNA as well as 
the Internal Control by means of the artus HSV-1/2 TM PCR Kit, the 
reporters/quenchers listed in the following table are to be defined: 

Detection  Reporter  Quencher 

HSV-1 DNA  FAM  Non Fluorescent 

HSV-2 DNA  NED  Non Fluorescent 

Internal Control (HSV TM IC)  VIC  Non Fluorescent 
 

 

To create these detectors, select the option New (bottom left of the Detector 
Manager). 
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Fig. 12: Creating the HSV-1 specific detector 
(Detector Manager). 

Fig. 13: Creating the HSV-2 specific detector 
(Detector Manager). 

 
Fig. 14: Creating the IC specific detector (Detector Manager) for HSV-1/HSV-2. 

For the detection of HSV-1 DNA and HSV-2 DNA define the reporter/quencher 
combination FAM/Non Fluorescent or NED/Non Fluorescent in the new 
window. For the detection of the Internal Control, select the combination 
VIC/Non Fluorescent (as shown in Fig. 12 – Fig. 14). By confirming the input 
data (OK), return to the Detector Manager. Mark the newly created detectors 
and transfer each selection to the Setup level by clicking on the option Copy to 
Plate Document (see Fig. 15). Close the window (Done). 
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Fig. 15: Selecting the detectors (Detector Manager). 

8.5.2.3 Assigning the Necessary Information to the Plate Positions 

After having closed the Detector Manager (Done) the detectors selected under 
8.5.2.2 are found on the Setup level listed in a table (see Fig. 16 – Fig. 17).  

 
Fig. 16: Assigning the necessary information (HSV-1) to the plate positions. 
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Fig. 17: Assigning the necessary information (HSV-2) to the plate positions. 

Mark the plate positions reserved for the detection of HSV DNA. Assign the 
selected detectors to these positions by activating the Use option of all three 
detectors, upon which a cross will appear. For the denomination of each single 
reaction, select the corresponding position on the plate and enter the name 
(Sample Name). Please note that preparations with an identical Sample Name 
and an identical detector assignment will be identified as replicates by the 
software and will be averaged with respect to the quantified pathogen load. 
Then select the corresponding function (Task) for each sample type according to 
the following table: 

Sample 
Type  

Function 
(Task)  

Concentration 
(Quantity)  

Reporter 
HSV-1  

Reporter 
HSV-2  Quencher 

Sample  Unknown  – FAM  NED Non 
Fluorescent 

Non-
template 
control  

NTC  – FAM NED Non 
Fluorescent 

Standard  Standard  see 1. Contents  FAM  NED  Non 
Fluorescent 

 

 

To generate a standard curve, use all supplied Quantitation Standards (HSV1 
LC/RG/TM QS 1 – 4 & HSV2 LC/RG/TM QS 1 – 4) per PCR run and enter the 
corresponding concentrations (see 1. Contents) for each standard (Quantity). 
Please note that for a PCR run with the artus HSV-1/2 TM PCR Kit, ROX has to 
be set as a passive reference (Passive Reference). The equal distribution of the 
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ROX dye in all PCR preparations of a lot by mixing of the HSV TM Master 
guarantees the recognition and calculation of tube-to-tube variations 
(fluorescence differences between several PCR preparations) by means of the 
Sequence Detection Software (normalization). 

8.5.2.4 Creating the Temperature Profile 

To create a temperature profile, switch from the Setup level to the Instrument 
level in the software. Enter the valid temperature profile for the detection of HSV 
DNA according to Fig. 18. Make sure that the reaction volume is set to 50 µl. 
The option 9600 Emulation should be activated, the pre-settings of the Ramp 
time and the Auto Increment should remain unchanged (Ramp Time: 0:00, Auto 
Increment: 0.0°C, 0.0 Seconds). 

 
Fig. 18: Creating the temperature profile. 

In addition, the Instrument level contains the option Data Collection. By selecting 
this option the window depicted in Fig. 19 is opened. Each ramp and each 
plateau temperature shows a Data Collection Icon, which illustrates the data 
being collected at this stage of the run. Remove all symbols except the one for 
the Annealing-Extension step (Stage2/Step2) by clicking on them in order to 
exclude unnecessary fluorescence measurements. The total run time and the 
data quantity will thus be kept at a minimum. 
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Fig. 19: Data collection. 

8.5.2.5 Saving the PCR Run 

Save the settings (Setup) as a template in order to make use of them again later 
in a modified or unchanged form. By saving the settings as an ABI PRISM SDS 
Template Document (*.sdt) in the Template Directory ([D:]\Program 
Files\Applied Biosystems\SDS 2.1\Templates, created by Applied Biosystems), 
this file may be selected directly in the New Document window from the 
Template list. Copies stored in other folders have to be opened via Browse. 
Before starting the PCR run, save it again as an ABI PRISM SDS Document 
(*.sds) in order to guarantee the saving of the data that will be collected during 
the course of the PCR. 

8.5.2.6 Starting the PCR Run 

Start the PCR run by selecting the option Start from the menu item Instrument. 
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9. Data Analysis 
A valid calibration of the dyes (Pure Spectra Component File) and the 
background (Background Component File) is necessary when putting the 
instruments into operation. These calibration files are required for the exact 
calculation of the results as follows: 

All interfering signals generated by the instruments which influence the 
measurement are eliminated by the Sequence Detection Software of the ABI 
PRISM Sequence Detection Systems by means of the Background Component 
File. 

Furthermore, interferences appear during multicolour analyses between the 
emission spectra of the single fluorescence dyes. The software of the ABI PRISM 
SDS compensates these interferences by calculations using the spectrum data of 
the individual dyes stored in the Pure Spectra Component File. The software uses 
the same file for the assignment of the fluorescence data comprising the entire 
measurable spectrum collected in the course of the PCR to the programmed 
detectors. The fluorescence data of the individual dyes are subsequently divided 
by the value obtained for the signal of the passive reference (ROX) in order to 
account for tube-to-tube variations (fluorescence differences between several 
PCR preparations). The thus normalized signals may then be evaluated by 
means of the Amplification Plot. The calibration files used for the evaluation of a 
PCR run are automatically stored with the saving of the run. If no calibration 
files are installed, please create these files according to the instructions given in 
the ABI PRISM SDS User Guide/Manual. 

If more than one artus TM PCR system is integrated in your PCR run (note 
temperature profile), these assays should be analysed separately. Samples 
with an identical Sample Name and an identical detector assignment will 
automatically be identified as replicates by the ABI PRISM 7000 and 7900HT 
SDS Software and will be averaged with respect to the quantified pathogen 
load. 

The following results are possible: 

1. A FAM fluorescence signal for HSV-1 or NED fluorescence signal for HSV-
2 are detected.  
The result of the analysis is positive: The sample contains HSV DNA. 
In this case, the detection of a VIC fluorescence signal (Internal Control) is 
dispensable, since high initial concentrations of HSV DNA (positive FAM 
fluorescence signal for HSV-1 and NED fluorescence signal for HSV-2) can 
lead to a reduced or absent fluorescence signal of the Internal Control 
(competition). 
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2. Neither a FAM fluorescence signal for HSV-1 nor a NED fluorescence 
signal for HSV-2 are detected. At the same time, a VIC fluorescence signal 
from the Internal Control appears.  
In the sample no HSV DNA is detectable. It can be considered 
negative.  
In the case of a negative HSV PCR the detected signal of the Internal 
Control rules out the possibility of PCR inhibition. 

3. Neither a FAM fluorescence signal for HSV-1 nor a NED fluorescence 
signal for HSV-2 nor a VIC fluorescence signal are detected.  
No diagnosis can be concluded.  
Information regarding error sources and their solution can be found in 10. 
Troubleshooting. 

Examples of positive and negative PCR reactions are given in Fig. 20 – 23 (ABI 
PRISM 7000 SDS) and 24 – 27 (ABI PRISM 7900HT SDS). 

 
Fig. 20: Detection of the Quantitation Standards (HSV1 LC/RG/TM QS 1 – 4) by measurement 
of the FAM fluorescence signal (ABI PRISM 7000 SDS). NTC: non-template control (negative 
control). 
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Fig. 21: Detection of the Internal Control (IC) by measurement of the VIC fluorescence signal 
(ABI PRISM 7000 SDS) with simultaneous amplification of the Quantitation Standards (HSV1 
LC/RG/TM QS 1 – 4). NTC: non-template control (negative control). 

 
Fig. 22: Detection of the Quantitation Standards (HSV2 LC/RG/TM QS 1 – 4) by measurement 
of the NED fluorescence signal (ABI PRISM 7000 SDS). NTC: non-template control (negative 
control). 
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Fig. 23: Detection of the Internal Control (IC) by measurement of the VIC fluorescence signal 
(ABI PRISM 7000 SDS) with simultaneous amplification of the Quantitation Standards (HSV2 
LC/RG/TM QS 1 – 4). NTC: non-template control (negative control). 

 

Fig. 24: Detection of the Quantitation Standards (HSV1 LC/RG/TM QS 1 – 4) by measurement 
of the FAM fluorescence signal (ABI PRISM 7900HT SDS). NTC: non-template control 
(negative control). 
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Fig. 25: Detection of the Internal Control (IC) by measurement of the VIC fluorescence signal 
(ABI PRISM 7900HT SDS) with simultaneous amplification of the Quantitation Standards 
(HSV1 LC/RG/TM QS 1 – 4). NTC: non-template control (negative control). 

 

Fig. 26: Detection of the Quantitation Standards (HSV2 LC/RG/TM QS 1 – 4) by measurement 
of the NED fluorescence signal (ABI PRISM 7900HT SDS). NTC: non-template control 
(negative control). 
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Fig. 27: Detection of the Internal Control (IC) by measurement of the VIC fluorescence signal 
(ABI PRISM 7900HT SDS) with simultaneous amplification of the Quantitation Standards 
(HSV2 LC/RG/TM QS 1 – 4). NTC: non-template control (negative control). 
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10. Troubleshooting 
Neither FAM fluorescence signal for HSV-1 nor NED fluorescence signal 
for HSV-2 with positive controls (HSV1 LC/RG/TM QS 1 – 4 & HSV2 
LC/RG/TM QS 1 – 4): 

 The selected detection dye for PCR data analysis does not comply with the 
protocol. 

 For data analysis select the detection dye FAM for HSV-1 and NED for 
HSV-2 for the analytical HSV PCR and the detection dye VIC for the 
Internal Control PCR. 

 The settings used for the data analysis under Options (Extension Phase 
Data Extraction) do not correspond to the settings of the Data Collection 
(for ABI PRISM 7900HT SDS see 8.5.2.4 Creating the Temperature Profile). 

 Analyse the PCR run with corrected settings and repeat the data analysis 
(Analysis). 

 Incorrect programming of the temperature profile of the ABI PRISM 
Sequence Detection System. 

 Compare the temperature profile with the protocol (see 8.5 Programming 
the ABI PRISM SDS). 

 Incorrect configuration of the PCR reaction. 

 Check your work steps by means of the pipetting scheme (see 
8.4 Preparing the PCR) and repeat the PCR, if necessary. 

 The storage conditions for one or more kit components did not comply with 
the instructions given in 2. Storage or the artus HSV-1/2 TM PCR Kit had 
expired. 

 Please check the storage conditions and the expiration date (see the kit 
label) of the reagents and use a new kit, if necessary. 

Weak or no signal of the Internal Control (VIC fluorescence signal) and 
simultaneous absence of a FAM fluorescence signal for HSV-1 and NED 
fluorescence signal for HSV-2 for the specific HSV PCR: 

 The PCR conditions do not comply with the protocol. 

 Check the PCR conditions (see above) and repeat the PCR with corrected 
settings, if necessary. 
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 The PCR was inhibited. 

 Make sure that you use a recommended isolation method (see 8.1 DNA 
Isolation) and stick closely to the manufacturer’s instructions. 

 Make sure that during the DNA isolation the recommended additional 
centrifugation step has been carried out before the elution in order to 
remove any residual ethanol (see 8.1 DNA Isolation). 

 DNA was lost during extraction. 

 If the Internal Control had been added to the extraction, an absent signal 
of the Internal Control can indicate the loss of DNA during the extraction. 
Make sure that you use a recommended isolation method (see 8.1 DNA 
Isolation) and stick closely to the manufacturer’s instructions. 

 The storage conditions for one or more kit components did not comply with 
the instructions given in 2. Storage or the artus HSV-1/2 TM PCR Kit had 
expired. 

 �Please check the storage conditions and the expiration date (see the kit 
label) of the reagents and use a new kit, if necessary. 

A FAM fluorescence signal for HSV-1 and NED fluorescence signal for 
HSV-2 of the analytical PCR with the negative controls: 

 A contamination occurred during preparation of the PCR. 

 Repeat the PCR with new reagents in replicates. 

 If possible, close the PCR tubes directly after addition of the sample to be 
tested. 

 Strictly pipette the positive controls at last. 

 Make sure that work space and instruments are decontaminated at 
regular intervals. 

 A contamination occurred during extraction. 

 Repeat the extraction and PCR of the sample to be tested using new 
reagents. 

 Make sure that work space and instruments are decontaminated at 
regular intervals. 

If you have any further questions or if you encounter problems, please contact 
our Technical Service. 
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11. Specifications 

11.1 Analytical Sensitivity 
In order to determine the analytical sensitivity of the artus HSV-1/2 TM PCR Kit, 
a standard dilution series has been set up for HSV-1 from 25.7 to nominal 
0.008 HSV copy equivalents*/µl and for HSV-2 from 35.31 to nominal 
0.012 HSV copy equivalents/µl and analysed by means of the ABI PRISM 7000 
and 7900HT Sequence Detection Systems with the help of the artus HSV-1/2 TM 
PCR Kit. Testing for all instruments was carried out on three different days on 
eight replicates. The results were determined by a probit analysis. A graphical 
illustration of the probit analysis (ABI PRISM 7900HT SDS) is shown in Fig. 28 
and 29. 

Detection limit (p = 0.05) 

ABI PRISM 7000 SDS (HSV-1)  0.9 copies/µl 

ABI PRISM 7000 SDS (HSV-2)  0.5 copies/µl 

ABI PRISM 7900HT SDS (HSV-1)  1.8 copies/µl 

ABI PRISM 7900HT SDS (HSV-2)  2.0 copies/µl 
 

 

This means that there is a 95 % probability that 0.9 copies/µl (HSV-1) or 0.5 
copies/µl (HSV-2, ABI PRISM 7000 SDS) and 1.8 copies/µl (HSV-1) or 2.0 
copies/µl (HSV-2, ABI PRISM 7900HT SDS) will be detected. 

* The standard is a cloned PCR product, the concentration of which has been determined by 
absorption and fluorescence spectroscopy. 
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Probit analysis: HSV-1 (ABI PRISM 7900HT SDS) 

 
Fig. 28: Analytical sensitivity for HSV-1 of the artus HSV-1/2 TM PCR Kit (ABI PRISM 7900HT 
SDS). 

Probit analysis: HSV-2 (ABI PRISM 7900HT SDS) 

 
Fig. 29: Analytical sensitivity for HSV-2 of the artus HSV-1/2 TM PCR Kit (ABI PRISM 7900HT 
SDS). 
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11.2 Specificity 
The specificity of the artus HSV-1/2 TM PCR Kit is first and foremost ensured by 
the selection of the primers and probes, as well as the selection of stringent 
reaction conditions. The primers and probes were checked for possible 
homologies to all in gene banks published sequences by sequence comparison 
analysis. The detectability of all relevant strains has thus been ensured. 

To determine the specificity of the artus HSV-1/2 TM PCR Kit the control group 
listed in the following table (see Table 1) has been tested for crossreactivity. 
None of the tested pathogens has been reactive. 

Table 1. Testing the specificity of the kit with potentially cross-reactive 
pathogens 

Control group 
HSV-1/2 

(FAM/NED) 
Internal Control 

(VIC) 

Human herpesvirus 3 (Varicella-zoster virus) – + 

Human herpesvirus 4 (Epstein-Barr virus) – + 

Human herpesvirus 5 (Cytomegalovirus) – + 

Human herpesvirus 6 A – + 

Human herpesvirus 6 B – + 

Human herpesvirus 7 – + 

Human herpesvirus 8 – + 

Hepatitis A virus – + 

Hepatitis B virus – + 

Hepatitis C virus – + 

Human immunodeficiency virus – + 

Human T cell leukemia virus 1 and 2 – + 

West-Nile-virus – + 

Enterovirus – + 

Parvovirus B19 – + 
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11.3 Precision 
The precision data of the artus HSV-1/2 TM PCR Kit allow the determination of 
the total variance of the assay. The total variance consists of the intra-assay 
variability (variability of multiple results of samples of the same concentration 
within one experiment), the inter-assay variability (variability of multiple 
results of the assay generated on different instruments of the same type by 
different operators within one laboratory) and the inter-batch variability 
(variability of multiple results of the assay using various batches). The data 
obtained were used to determine the standard deviation, the variance and the 
coefficient of variation for the pathogen specific and the Internal Control PCR. 

Precision data of the artus HSV-1/2 TM PCR Kit have been collected using the 
Quantitation Standard of the lowest concentration (QS 4; 10 copies/µl). Testing 
was performed with eight replicates. The precision data were calculated on 
basis of the Ct values of the amplification curves (Ct: threshold cycle, see 
Table 2/Table 4). In addition, precision data for quantitative results in copies/µl 
were determined using the corresponding Ct values (see Table 3/Table 5). 
Based on these results, the overall statistical spread of any given sample with 
the mentioned concentration is 2.62 % (Ct; HSV-1) and 2.07 % (Ct; HSV-2) or 
14.02 % (conc., HSV-1) and 14.82 % (conc., HSV-2), for the detection of the 
Internal Control 1.84 % (Ct; HSV-1) and 1.92 % (Ct; HSV-2). These values are 
based on the totality of all single values of the determined variabilities. 
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Table 2. Precision data for HSV-1 on basis of the Ct values 

 
Standard 
deviation  Variance  

Coefficient of 
variation [%] 

Intra-assay variability: 

HSV1 LC/RG/TM QS 4 
0.18 0.03 0.51 

Intra-assay variability: 

Internal Control 
0.24 0.06 0.87 

Inter-assay variability: 

HSV1 LC/RG/TM QS 4 
0.25 0.06 0.70 

Inter-assay variability: 

Internal Control 
0.37 0.14 1.36 

Inter-batch variability: 

HSV1 LC/RG/TM QS 4 
0.23 0.05 0.67 

Inter-batch variability: 

Internal Control 
0.17 0.03 0.65 

Total variance: 

HSV1 LC/RG/TM QS 4 
0.92 0.84 2.62 

Total variance: 

Internal Control 
0.49 0.24 1.84 

 

Table 3. Precision data for HSV-1 on basis of the quantitative results (in 
copies/µl) 

 
Standard 
deviation  Variance  

Coefficient of 
variation [%] 

Intra-assay variability: 

HSV1 LC/RG/TM QS 4 
1.32 1.75 13.12 

Inter-assay variability: 

HSV1 LC/RG/TM QS 4 
1.60 2.56 15.81 

Inter-batch variability: 

HSV1 LC/RG/TM QS 4 
1.22 1.50 12.14 

Total variance: 

HSV1 LC/RG/TM QS 4 
1.42 2.00 14.02 
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11.4 Robustness 
The verification of the robustness allows the determination of the total failure 
rate of the artus HSV-1/2 TM PCR Kit. 30 HSV negative samples of 
cerebrospinal fluid were spiked with 5.4 copies/µl elution volume of HSV-1 
control DNA (threefold concentration of the analytical sensitivity limit). After 
extraction using the QIAamp DNA Mini Kit (see 8.1 DNA Isolation) these 
samples were analysed with the artus HSV-1/2 TM PCR Kit. The analysis of HSV-
2 has been carried out similarly (30 cerebrospinal fluid samples, 6 copies/µl 
HSV-2 control DNA). For all HSV-1 and HSV-2 samples the failure rate was 
0 %. In addition, the robustness of the Internal Control was assessed by 
purification and analysis of 30 HSV negative cerebrospinal fluid samples. The 
total failure rate was 0 %. Inhibitions were not observed. Thus, the robustness of 
the artus HSV-1/2 TM PCR Kit is ≥99 %. 

11.5 Reproducibility 
Reproducibility data permit a regular performance assessment of the artus HSV-
1/2 TM PCR Kit as well as an efficiency comparison with other products. These 
data are obtained by the participation in established proficiency programmes. 

11.6 Diagnostic Evaluation 
Currently, the artus HSV-1/2 TM PCR Kit is undergoing a series of evaluation 
studies. 

12. Product Use Limitations 
 All reagents may exclusively be used in in vitro diagnostics. 

 The product is to be used by personnel specially instructed and trained in 
the in vitro diagnostics procedures only. 

 Strict compliance with the user manual is required for optimal PCR results. 

 Attention should be paid to expiration dates printed on the box and labels 
of all components. Do not use expired components. 

13. Warnings and Precautions 
For safety information of the artus HSV-1/2 TM PCR Kit, please consult the 
appropriate safety data sheet (SDS). The SDS are available online in convenient 
and compact PDF format at www.qiagen.com/safety. 
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14. Quality Control 
In accordance with QIAGEN’s ISO 9001 and ISO 13485-certified Total Quality 
Management System, each lot of artus HSV-1/2 TM PCR Kit is tested against 
predetermined specifications to ensure consistent product quality. 

15. References 
Mackay IM. Real-time PCR in the microbiology laboratory. Clin. Microbiol. 
Infect. 2004; 10 (3): 190 – 212. 

16. Explanation of Symbols 

 

Use by 

 Batch code 

 
Manufacturer 

 Catalogue number 

 Material number 

 Handbook 

 In vitro diagnostic medical device 

 Global Trade Item Number 

 <N> 
Contains sufficient for <N> tests 

 

Temperature limitation 

 Quantitation Standard 

 Internal Control 

 Magnesium Solution 
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